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Q.1   मागून जन्मलेला - समुहदर्शक शब्द ओळखा.

A. अपूर्व
B. अजातशत्रू
C. अनुज
D. अग्रज

Answer: C

Sol: - अनुज -
- अपूर्व = पूर्वी कधीही न झालेला.
- अजातशत्रू = ज्यास कोणीही शत्रू नाही असा.
- अग्रज = आधी जन्मलेला.

Q.2   महाराष्ट्र -महान असे राष्ट्र  या समासाचा प्रकार ओळखा.

A. कर्मधारय समास
B. द्विगू समास
C. मध्यमपदलोपी समास
D. द्वंद्व समास

Answer: A

Sol: - कर्मधारय समास -
- कर्मधारय समास - सामासिक शब्दातील पहिल्या पदाचा दुसऱ्या पदाशी संबंध दाखविणारी मधली काही पदे  लोप करावी करावी लागतात. म्हणून या समासाला कर्मधारय समास
म्हणतात.

Q.3   नाकी नऊ येणे या वाक्प्रचाराचा अर्थ पर्याय निवडा.

A. नऊ संकटे येणे
B. सर्दी होणे
C. नाक चोंदणे
D. बेजार होणे

Answer: D

Sol: नाकी नऊ येणे म्हणजे बेजार होणे

Q.4   तुला कु ठे  जायचे आहे? हायलाईट के लेला सर्वनामाचा प्रकार कोणता?

A. द्वितीय पुरुषवाचक सर्वनाम
B. प्रथम पुरुषवाचक सर्वनाम
C. तृतीय पुरुषवाचक सर्वनाम
D. चतूर्थ पुरुषवाचक सर्वनाम

Answer: A

Sol: तुला हे व्दिताय पुरुषवाचक सर्वनाम आहे.
प्रथम पुरुषवाचक - मी
व्दितीप पुरुषवाचक - तू
तृतीय पुरुषवाचक -

Q.5   बोका या शब्दाचा विरुद्ध लिंगी शब्द पर्यायातून निवडा.
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A. बोका
B. बोके
C. बोको
D. भाटी

Answer: D

Sol: बोका या पुल्लीं गी शब्दाचे स्त्रिलिंगी रूप भाटी होते.

Q.6   शुद्ध शब्द ओळखा.

A. नीर्भत्सना
B. निर्भत्सना
C. निर्भर्त्सना
D. निर्भत्साना

Answer: C

Sol: निर्भर्त्सना -
- न चार उच्चार तोकडा असल्याने न ला इ लागून निहा ऱ्हस्व वर्ण तयार झाला.

Q.7   पुढील वाक्याचा प्रकार ओळखा.
वादळ आले आणि लोकांची पळापळ झाली.

A. मिश्र वाक्य
B. के वळ वाक्य
C. संयुक्त वाक्य
D. प्रधान वाक्य

Answer: C

Sol: संयुक्त वाक्य -
- संयुक्त वाक्य = दोन किं वा अधिक के वळ वाक्ये प्रधानत्वबोधक उभयान्वयी अव्ययाने जोडली असता जे एक जोडवाक्य तयार होते. त्यास संयुक्त वाक्य म्हणतात.

Q.8   तो किती सुंदर गुलमोहोर आहे –
या वाक्याच्या शेवटी कोणते विरामचिन्ह येईल ?

A. प्रश्नचिन्ह
B. उद्गारवाची
C. पूर्णविराम
D. स्वल्पविराम

Answer: C

Sol: पूर्णविराम
विधान किं वा वाक्य पूर्ण झाले हे दाखवण्यासाठी पूर्ण विराम वापरतात.
- शब्दाचा संक्षेप दाखविण्यासाठी आदयाक्षरांपुढे
- पूर्ण विराम चिन्ह ( . )

Q.9   मराठीतील पहिल्या स्त्री कांदबरीकार – कोण होत्या ?

A. साळू बाई तांबेकर
B. सावित्रीबाई फु ले
C. बहिणाबाई चौधरी
D. प्रज्ञा दया पवार

Answer: A
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Sol: साळू बाई तांबेकर
मराठीतील पहिल्या स्त्री कांदबरीकर – साळू बाई तांबेकर – चंद्रप्रथा विरह वर्णन – 1769
मराठीतील पहिल्या समाजिक कांदबरी – यमुना पर्यटन – बाबा पद्मजी – 1860
मराठीतील आदच गीतभाष्य – ज्ञानेश्वरी (नेवसे)

Q.10   मराठी भाषेत एकू ण किती व्यंजने आहेत ?

A. 48
B. 34
C. 12
D. 25

Answer: B

Sol: - 34
- एकु ण व्यंजने - 34
- एकु ण स्वर - 14
- मराठीतील लोप पावत असलेला स्वर - लृ
- इंग्रजी नवीन स्वर - ॲ, ऑ.

Q.11   Select the most appropriate option to fill in the blank.
She was waiting for them for a long time, ______?

A. weren’t they
B. was she
C. wasn’t she
D. were they

Answer: C

Sol: The correct option to fill in the blank is (c) wasn’t she.
Explanation: Question tags repeat the auxiliary from the main clause, reverse the polarity, and use a pronoun matching the subject. Main clause: She
was waiting… (affirmative, auxiliary was). Therefore, tag = wasn’t she? (negative + subject pronoun she). (हिंदी भाव: “वह काफ़ी देर से इंतज़ार कर रही थी, है
ना?”)
Example: They were late, weren’t they? / He is ready, isn’t he?
Explain why other options are incorrect.
· (a) weren’t they: wrong auxiliary ( were ≠ was) and wrong pronoun ( they ≠ she).
· (b) was she: same polarity as the statement — tag must be negative.
· (d) were they: wrong auxiliary and pronoun.
Information booster (tags): Imperatives often take will you? / won’t you?; with Let’s, use shall we?; with negative statements, the tag is usually
affirmative.

Q.12   A sentence has been given with a blank to be filled with an appropriate word. Choose the correct alternative.
Jane gets pretty __________ when she is drunk.

A. innate
B. sulk
C. vicious
D. glowing

Answer: C

Sol:
The correct option to fill in the blank is (c) vicious.
Explanation:
The sentence describes Jane’s behavior when she is drunk. In such contexts, the word that fits naturally is vicious, meaning aggressive, cruel, or
violent.
The other options do not describe a behavior typically associated with being drunk, making vicious the most appropriate choice.
Meanings of other options:
· (a) innate: Natural or inborn; something present from birth (जन्मजात)
· (b) sulk: To remain silent or bad-tempered out of annoyance (नाराज़ होकर चुप रहना)
· (d) glowing: Shining, radiant, or showing strong emotion (दमकता हुआ, चमकदार)
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Q.13   'I haven't studied a lot lately'. Here, 'lately' is a/an

A. Adverb
B. Adjective
C. Noun
D. Preposition

Answer: A

Sol: The correct answer is (a) Adverb.
Explanation:
“Lately” describes when the action of studying occurred. It modifies the verb “studied”, so it functions as an adverb of time. (Lately = हाल ही में)
Example:
· I have been feeling tired lately.
Why other options are incorrect:
· (b) Adjective – Adjectives describe nouns, not actions.
· (c) Noun – A naming word; "lately" does not name anything.
· (d) Preposition – A word showing relation, e.g., in, on, under.

Q.14   Select the correct option:
Rare though the phenomenon is, it can occur _________ prolonged drought conditions.

A. towards
B. amid
C. among
D. under

Answer: D

Sol: The correct option to fill in the blank is (d) under.
Explanation: We use under with “conditions” to indicate a controlling/prevailing state: under X conditions. Hence, “occur under prolonged drought
conditions” is the standard prepositional pairing. (Hindi: … की परिस्थितियों में/के  अधीन)
Example: Wildfires often intensify under prolonged drought conditions.
Explain why other options are incorrect:
· (a) towards: in the direction of/with regard to; not used with “conditions” in this sense (Hindi: की ओर/के  प्रति)
· (b) amid: in the middle of; suits countable surrounding events (e.g., amid protests), less natural with “conditions” where under is idiomatic (Hindi: के
बीच)
· (c) among: in the company of/between members of a group; not used for general “conditions” (Hindi: के  बीच/में)

Q.15   Select the most appropriate option to fill in the blank.
Like the judiciary the newspaper should have an _________ outlook in reporting news.

A. enigmatic
B. important
C. impartial
D. initial

Answer: C

Sol: The correct option to fill in the blank is (c) impartial.
The sentence compares the newspaper with the judiciary, both of which are expected to be fair and unbiased. The newspaper’s outlook in reporting
news should be neutral, not favouring any side. The word that correctly expresses this idea is “impartial”, meaning fair, just and without bias. (Hindi
meaning: निष्पक्ष, पक्षपात रहित)
Example:
· A good journalist must remain impartial while reporting political events.
Explain why other options are incorrect:
· (a) enigmatic: Mysterious, difficult to understand, puzzling. (Hindi meaning: रहस्यमय, बुझ न सकने वाला) – A newspaper’s outlook should not be
“mysterious”; it should be clear and fair.
· (b) important: Having great significance or value. (Hindi meaning: महत्वपूर्ण, अहम) – “Important outlook” is not a natural collocation and does not
convey the idea of fairness.
· (d) initial: At the beginning, first, early stage. (Hindi meaning: प्रारं भिक, आरम्भिक) – “Initial outlook” refers to the first view, not to fairness or neutrality.
Thus, only “impartial” correctly matches the idea of a fair and unbiased outlook, just like the judiciary.
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Q.16   Find the part of the given sentence that has an error in it. If there is no error, choose 'No error'.
I am too glad to (1) /meet you after (2) /so many days (3) /.No error (4)

A. 3
B. 2
C. 1
D. 4

Answer: C

Sol:
Option (1) contains an error.
Explanation:
The phrase “I am too glad” is incorrect.
The word “too” means excessively, and it is generally used for negative or undesirable situations (e.g., too hot, too tired, too late).
Emotions that are positive, such as glad, cannot be used with “too” in this sense.
The correct expression should be “I am very glad” or “I am so glad.”
Grammatical rule used:
“Too” is used to show excess, often leading to an undesirable result.
Positive feelings or desirable adjectives should be paired with “very” instead of “too.”
Explanation of the rule in Hindi:
“Too” का प्रयोग तब किया जाता है जब किसी चीज़ की मात्रा ज़रूरत से ज़्यादा हो और उसका परिणाम नकारात्मक हो।
सकारात्मक भावनाओं (जैसे glad, happy) के  साथ “very” का प्रयोग किया जाता है।
Example:
• I am very happy to see you.
• The tea is too hot to drink.

Q.17  
Abstract noun form of “invite” is –

A. invited
B. inviting
C. invitation
D. invitee

Answer: C

Sol:
· “Invite” = to ask someone to come.
· “Invitation” is the noun meaning a written or spoken request to come.
· Example: I received an invitation to the wedding.
Other options
· invited – V2/V3 or adjective ( invited guests).
· inviting – V+ing or adjective ( an inviting smell).
· invitee – the person who is invited (concrete noun).
Rule:
Verb + -tion / -sion → abstract noun: inform → information, operate → operation, invite → invitation.

Q.18   Arrange the sentence parts:
(A) my mother
(B) bought
(C) a beautiful saree
(D) yesterday

A. ABCD
B. CBAD
C. ACBD
D. BACD

Answer: A

Sol: Option (a) is the correct order of the given sentences.
Why ABCD is correct:
· A (Subject): “my mother” — subjects usually come first.
· B (Verb): “bought” — follows the subject to form an SV core.
· C (Object): “a beautiful saree” — the direct object naturally follows the verb to form SVO.
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· D (Adverbial of time): “yesterday” — time expressions typically appear at the end: S + V + O + (Time).
· The result “My mother bought a beautiful saree yesterday.” is grammatically and stylistically standard English (adjective “beautiful” correctly
pre-modifies the noun “saree”).

Q.19   Select the most appropriate meaning of the given idiom.
Pull someone's leg

A. To joke with someone
B. To refrain from humour
C. To tightly cling on to someone
D. To pull the trigger

Answer: A

Sol: Option (a) is the correct meaning of the given idiom.
Given Idiom – ‘Pull someone’s leg’:
· This idiom means to tease or joke with someone in a playful, friendly way, often by telling them something untrue just for fun and then admitting
the joke.
· It does not mean hurting someone; it is a light-hearted or humorous act of making fun of someone without bad intention.
· Hindi idiomatic meaning: किसी के  साथ मज़ाक करना, हल्के -फु ल्के  अंदाज़ में छेड़ना, किसी को हंसी-मज़ाक में बेवकू फ बनाना
Example (Idiom used in a sentence):
· Don’t worry, he’s just pulling your leg; he didn’t really see a ghost in the classroom.
Other related idioms and their meanings:
· Crack a joke – To tell a joke to make people laugh. (Hindi: मज़ाक करना / चुटकु ला सुनाना)
· Make fun of someone – To laugh at or tease someone, sometimes in an unkind way. (Hindi: किसी का मज़ाक उड़ाना)
· Take something in good humour – To accept a joke or teasing without getting offended. (Hindi: मज़ाक को हँसी में टाल देना)
· Have a laugh at someone’s expense – To laugh by making someone the subject of a joke. (Hindi: किसी की कीमत पर हँसी-मज़ाक करना)

Q.20   Select the most appropriate option to fill in the blank.
When________manuscripts to book publishing houses, extreme caution should be taken.

A. evaluating
B. proof reading
C. submitting
D. editing

Answer: C

Sol: The correct option to fill in the blank is (c) submitting.
Explanation: The sentence needs a gerund/participial form to indicate the action being performed: When submitting manuscripts…. This best fits
the context of sending work to publishers. (Hindi meaning of submit: प्रेषित/जमा करना)
Example: When submitting manuscripts to journals, follow their guidelines carefully.
Explain why other options are incorrect.
· evaluating: assessing/appraising (Hindi: मूल्यांकन करना); publishers evaluate—writers submit.
· proof reading: should be proofreading; means checking for errors (Hindi: प्रूफ पढ़ना); not the act of sending.
· editing: revising/improving text (Hindi: संपादन करना); happens before submission.

Q.21   Choose the option in which the following words/phrases can be arranged to form a correct sentence.
A. may live
B. eat so
C. we
D. that we

A. C, B, D, A
B. D, A, C, B
C. B, D, A, C
D. A, C, B, D

Answer: A

Sol: Option (a) is the correct order of the given sentences.
Correct sentence: We eat so that we may live.
Explanation of sequence:
· Sentence starts with subject "we" (C).
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· Verb phrase "eat so" (B) follows.
· Purpose clause "that we" (D) connects purpose.
· Final phrase "may live" (A) concludes the purpose.
Why correct order:
· Subject → Verb → Purpose clause → Result clause.
· Grammatically and logically correct structure.
Other options fail because:
· They disturb the natural SVO order or the purpose clause placement.

Q.22   Fill in the blanks with suitable determiners from the given options.
The leader has shown ___________ extraordinary commitment during the times of pandemic.

A. a
B. Some
C. an
D. the

Answer: C

Sol: The correct option to fill in the blank is (c) an.
We use an before a word beginning with a vowel sound. Extraordinary begins with the vowel sound /ɛk…/; hence an extraordinary commitment is
correct and idiomatic. (extraordinary = असाधारण, विलक्षण) Even though commitment can be uncountable in general, in this collocation we treat it as a
countable instance of commitment—hence the article is natural.
Example: The volunteers displayed an extraordinary commitment to service.
Explain why other options are incorrect.
· (a) a: incorrect because a is not used before a vowel sound.
· (b) Some: ( कु छ/काफी) typically pairs with plural count nouns or uncountables but shifts the meaning; the fixed collocation is an extraordinary
commitment, not some extraordinary commitment in formal evaluation.
· (d) the: ( वह/वे/निर्दिष्ट) would point to a previously specified, definite commitment; here we introduce the quality first, so an is preferred.
Information booster: The choice between a/an depends on sound, not letter: an honest man (vowel sound), a university (consonant /juː/ sound).

Q.23   Select the INCORRECTLY spelt word.

A. Entrepreneur
B. Wierd
C. Heretic
D. Psychology

Answer: B

Sol: Option (b) is the incorrectly spelt word.
Correct spelling is: “weird” – meaning strange, unusual or difficult to understand; very odd in a surprising or unsettling way (अजीब, विचित्र, असामान्य).
· It is used when something does not appear normal or ordinary and feels strange.
· Spelling tip: The correct vowel order is “ei” → w eird, not “ie”.
Example:
· That movie was so weird that I couldn’t understand what was happening.
Meanings of all the given options:
· (a) Entrepreneur – a person who starts and runs a business, especially one involving financial risk (उद्यमी, व्यवसाय शुरू करने वाला व्यक्ति).
· (b) Wierd – incorrect spelling of “weird” (अजीब/विचित्र).
· (c) Heretic – a person holding religious or other beliefs that are at odds with what is generally accepted (विधर्मी, प्रचलित मत के  विरुद्ध विचार रखने वाला
व्यक्ति).
· (d) Psychology – the scientific study of the mind and behaviour (मनोविज्ञान, मानव व्यवहार और सोच का विज्ञान).

Q.24   Select the most appropriate synonym of the given word.
Calamity

A. Tranquillity
B. Fortune
C. Disaster
D. Prosperity

Answer: C
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Sol: The correct synonym of the given word is (c) Disaster.
Given word: Calamity
· Meaning: A sudden event that causes great damage or distress; a serious misfortune or catastrophe affecting many people. (आपदा, महाविपत्ति, बड़ा
संकट)
Example (using the given word):
· The flood turned into a calamity for the villagers, destroying their homes and crops.
· (बाढ़ गाँववालों के  लिए एक आपदा बन गई, जिसने उनके  घर और फसल दोनों नष्ट कर दिए।)
Correct answer word: Disaster
· Meaning: A sudden accident or natural event that causes great damage or loss of life; any very bad situation or failure. (आपदा, विपत्ति)
Example (using the correct answer word):
· The earthquake was a major disaster that left thousands of people homeless.
· (भूकं प एक बड़ी आपदा था, जिसने हजारों लोगों को बेघर कर दिया।)
Synonyms (for Calamity):
· Disaster, Catastrophe, Tragedy, Misfortune
Antonyms (for Calamity):
· Fortune, Blessing, Boon, Prosperity
Meanings of all the other given options:
· (a) Tranquillity: a state of peace and calm, free from disturbance (शांति, सुकू न, शांति की अवस्था)।
· (b) Fortune: good luck or success; also a large amount of money (भाग्य, किस्मत, सौभाग्य; धन-दौलत)।
· (d) Prosperity: a state of being successful and having plenty of money and resources (समृद्धि, खुशहाली, उन्नति)।

Q.25   Select the INCORRECTLY spelt word.

A. Animated
B. Narrated
C. Designeted
D. Separated

Answer: C

Sol: Option (c) is the incorrectly spelt word.
Correct spelling is: “Designated.”
· Meaning: Officially chosen, named or appointed for a particular job, purpose or position. (Hindi: नियुक्त, नामित, निर्धारित)
· Example: He was designated as the new coordinator for the event.
Meanings of all the given options:
· (a) Animated: Full of life and energy; lively. It can also refer to cartoon-style motion pictures. (Hindi: जीवंत, उत्साही, एनिमेटेड)
· (b) Narrated: Described or told a story or series of events, generally in words. (Hindi: किस्सा सुनाया, वर्णन किया)
· (c) Designeted: Incorrect spelling of “designated”. Correct word means officially chosen or appointed. (Hindi: (गलत वर्तनी) — सही शब्द: designated =
नियुक्त, नामित)
· (d) Separated: Divided or kept apart; not together anymore. (Hindi: अलग किया हुआ, पृथक, जुदा)
Thus, Animated, Narrated, and Separated are correctly spelt, while Designeted is incorrect; the right spelling is Designated.

Q.26   The following sentence is in ______ tense.
Rohan goes to the gym every morning.

A. Simple present tense
B. Present continuous tense
C. Simple past tense
D. Simple future tense

Answer: A

Sol: The verb “goes” tells us about a regular habit in the present.
· In simple present tense, we use V1 / V1+s (go/goes, play/plays) to talk about habits, routines and facts.
· Here, “Rohan goes to the gym every morning” shows a daily routine.
· So, this sentence is in simple present tense.

Q.27   Select the most appropriate option to fill in the blank.
You may sit __________ you like.

A. however
B. wherever
C. which
D. whatever
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Answer: B

Sol: The correct option to fill in the blank is (b) wherever.
Here the sentence “You may sit ________ you like” means “You can sit in any place that you prefer.” The word “wherever” is used to express “in any
place” or “at any place”, and it works perfectly with the idea of free choice of place.
Explanation of correct answer in minimum 2 lines.
· Wherever is used as a relative adverb / conjunction of place meaning “in any place, no matter which place”. (Hindi: जहाँ भी, किसी भी स्थान पर)
· With modal verbs like may / can, we often use “wherever” to show freedom of choice: “You may sit wherever you like” = “You are free to sit at any
place you want.”
Example:
· You may keep your bag wherever you like.
· तुम अपना बैग जहाँ भी चाहो, रख सकते हो।
Explain why other options are incorrect:
· (a) however: Means “in whatever way” or “no matter how”. (Hindi: जैसे भी, चाहे जिस प्रकार से) – It is used for manner, not for place. Example: “You may
dress however you like.” So it does not fit with “sit … you like” (place idea).
· (c) which: Used as a relative pronoun to refer to things already mentioned. (Hindi: जो, कौन सा) – It cannot directly follow a preposition-less structure
like this to indicate place: “You may sit which you like” is grammatically wrong.
· (d) whatever: Means “anything that” or “no matter what”. (Hindi: जो भी, कु छ भी) – It refers to things, not places. “You may sit whatever you like” is
incorrect English.
Information booster (grammar point):
· Where / wherever / whenever / however often introduce adverb clauses:
· Wherever = in any place (जहाँ भी)
· Whenever = at any time (जब भी)
· However = in any way / no matter how (जैसे भी)
· Pattern: “You may + V + wherever / whenever / however + you like.”
· You may go wherever you like.
· You can call me whenever you need help.

Q.28   Select the most appropriate ANTONYM of the given word.
Wisdom

A. Insight
B. Enlightenment
C. Folly
D. Foresight

Answer: C

Sol: The correct antonym of the given word is (c) Folly.
Given word: Wisdom – sound judgment and the ability to make prudent decisions based on knowledge and experience; deep understanding of life
and consequences. (हिंदी अर्थ: बुद्धिमत्ता/प्रज्ञा, विवेकपूर्ण निर्णय लेने की क्षमता)
Example: With wisdom, the leader resolved the conflict without violence.
#Correct answer word#: Folly – lack of good sense; foolishness; actions or ideas showing poor judgment. (हिंदी अर्थ: मूर्खता/अविवेक)
Example: Investing all his savings without research was sheer folly.
Synonyms: sagacity, prudence, discernment, good judgment.
Antonyms: folly, stupidity, foolishness, imprudence.
Meanings of all the other given options:
· (a) Insight: deep understanding of a person/thing (हिंदी: अंतर्दृष्टि)
· (b) Enlightenment: gaining profound knowledge/spiritual insight (हिंदी: ज्ञानोदय)
· (d) Foresight: ability to anticipate future needs/events (हिंदी: दू रदर्शिता)

Q.29   The following sentence is in ______ tense.
She had been studying for three hours before her friend arrived.

A. Past perfect tense
B. Past perfect continuous tense
C. Simple past tense
D. Past continuous tense

Answer: B

Sol: The verb group “had been studying” has “had been + V-ing”.
· Past perfect continuous tense shows an action that was going on for some time in the past and stopped before another past action.
· She started studying earlier, kept studying for three hours, and then her friend arrived.
· So, the sentence is in past perfect continuous tense.
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Q.30   Select the most appropriate homonym to fill in the blank.
The _____ pierced through the skin.

A. nail
B. teeth
C. stone
D. stick

Answer: A

Sol: The correct option to fill in the blank is (a) nail.
A “nail” (कील/नाखून) is a homonym: it can mean a metal fastener or a fingernail/toenail. In the given sentence, the context clearly points to the metal
fastener, which can pierce through skin. Hence, “nail” best fits the sense of sharp penetration implied by “pierced”.
Example: The rusty nail pierced his finger while he was fixing the board.
Explain why other options are incorrect.
· (b) teeth: Teeth (दाँत) usually bite or tear; we don’t normally say “the teeth pierced through the skin” without specifying fangs/canine context.
· (c) stone: Stone (पत्थर) hits/strikes; it doesn’t naturally “pierce” like a pointed object.
· (d) stick: Stick (डंडा/छड़ी) is typically blunt; it may bruise rather than pierce.

Q.31   Who among the following is the communication channel between the Council of Ministers and the President of India?

A. Speaker of the Lok Sabha
B. The Vice-President
C. The Prime Minister
D. Chairman of the Rajya Sabha

Answer: C

Sol: The correct answer is (C) Prime Minister
Explanation:
● As per Article 78(b) of the Indian Constitution, the Prime Minister acts as the official communication link between the Council of Ministers and the
President.
● It is the duty of the Prime Minister to inform the President about all decisions taken by the Council of Ministers.
● The President performs executive functions based on the aid and advice of the Prime Minister and Council of Ministers.
Information Booster:
● Mentioned in Article 78 of the Constitution.
● PM is the real executive head of India.
● PM allocates portfolios to ministers.
● President acts on aid & advice of Council of Ministers.
● PM coordinates between Cabinet & President.
Additional Knowledge:
● Speaker – Presides over Lok Sabha, no role with President.
● Vice-President – Chairman of Rajya Sabha.

Q.32   In February 2025, five cheetahs were released into which national park of India?

A. Kuno National Park
B. Periyar Wildlife Sanctuary
C. Gir National Park
D. Kanha National Park

Answer: A

Sol: Correct Answer: A — Kuno National Park

Explanation:

In February 2025, five cheetahs were released into the wild at Kuno National Park (KNP) in Madhya Pradesh.
This release was part of India’s cheetah reintroduction programme to restore the species after decades of local extinction.

Information Booster:

The cheetahs released included one female named “Jwala” (brought from Namibia) and her four cubs.
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Kuno National Park was selected for this project because it has a large prey base, suitable habitat and lesser human-wildlife conflict compared
to many other areas.

Additional Knowledge:

Option B — Periyar Wildlife Sanctuary: Located in Kerala, this sanctuary is known for elephants and tigers, not cheetah reintroduction.
Option C — Gir National Park: In Gujarat, this park is famous for the remaining population of Asiatic lions, not cheetahs.
Option D — Kanha National Park: Also in Madhya Pradesh, it is a tiger reserve and not the site of the February 2025 cheetah release.

Q.33   Where was the Peshwa sent away with a pension after the Third Anglo-Maratha War?

A. Poona
B. Nagpur
C. Surat
D. Bithur

Answer: D

Sol: The correct answer is: (D) Bithur
Explanation:
● After the Third Anglo-Maratha War (1817–1818), the Peshwa Bajirao II was defeated by the British.
● He was removed from power and sent away to Bithur (near Kanpur, Uttar Pradesh) with a pension of ₹8 lakh per year.
● This marked the end of the Maratha Confederacy’s political power.
● Bithur became his residence until his death in 1851.
● The British then annexed the territories and strengthened their control in India.
Additional Knowledge:
● The Third Anglo-Maratha War ended in 1818.
● It led to the Abolition of the Peshwaship.
● Peshwa Bajirao II was the last Peshwa of the Maratha Empire.
● Treaty of Bassein (1802) had already weakened the Marathas.
● This war paved the way for British supremacy in India.

Q.34   'Gandhi Sagar Dam' is constructed on which of the following rivers?

A. Mahi river
B. Hindon river
C. Chambal river
D. Betwa river

Answer: C

Sol: The correct answer is (c) Chambal river
Explanation:
· River: The Gandhi Sagar Dam is constructed on the Chambal River.
· Location: It is located in the Mandsaur district of Madhya Pradesh.
· Significance: It was the first of the four major dams built as part of the Chambal Valley Project (a joint venture between Rajasthan and Madhya
Pradesh). The foundation stone was laid by Prime Minister Jawaharlal Nehru in 1954.
· Purpose: It is a multipurpose gravity dam used for both irrigation and hydroelectric power generation.
Additional Information (Other Options):
· (a) Mahi river: The major dam on the Mahi river is the Mahi Bajaj Sagar Dam (located in Banswara, Rajasthan).
· (b) Hindon river: A tributary of the Yamuna, flowing through Western Uttar Pradesh (near Ghaziabad/Noida). It does not have a major dam of this
scale.
· (d) Betwa river: The major dams on the Betwa river include the Matatila Dam and the Rajghat Dam (border of UP and MP).
Information Booster:
· Chambal Valley Project Series: The four dams on the Chambal River in order of flow are:
1. Gandhi Sagar Dam (Madhya Pradesh)
2. Rana Pratap Sagar Dam (Rajasthan)
3. Jawahar Sagar Dam (Rajasthan)
4. Kota Barrage (Rajasthan).

Q.35   Which is a central problem of an economy?

A. Allocation of resources
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B. Optimum utilisation of resources
C. Economic development
D. All of these

Answer: A

Sol: The correct answer is (a) Allocation of resources.
The central problem of any economy is how to allocate scarce resources among unlimited wants.

This involves deciding what to produce, how to produce, and for whom to produce.

Proper allocation is essential because resources are limited while human wants are unlimited.

Information Booster:

Scarcity of resources necessitates efficient allocation.

Optimum utilization follows after resources are allocated.

Economic development depends on proper resource allocation and utilization.

Allocation decisions affect production, distribution, and consumption.

Different economic systems solve allocation problems differently.

Misallocation leads to wastage and inefficiency.

Allocation impacts economic growth and standard of living.

Additional Information:

Optimum utilisation of resources: Important but a result of allocation.

Economic development: A broader goal influenced by allocation and utilization.

All of these: Too broad; allocation is the fundamental problem.

Q.36   Anant Nag received the Padma Bhushan in 2025 for his work in which of the following fields?

A. Art
B. Literature
C. Public Affairs
D. Journalism

Answer: A

Sol: Correct Answer is:A) Art

Explanation:

The veteran actor Anant Nag was awarded the Padma Bhushan in 2025 for his contributions in the field of Art.
He has worked in over 300 films across various languages and is celebrated for his impact on cinema and theatre.

Information Booster:

The Padma Bhushan is India’s third-highest civilian honour, awarded for “distinguished service of a high order” in various fields.
Anant Nag’s career spans over 50 years, with significant contributions to Kannada, Hindi, Malayalam, Telugu and Marathi cinema.

Additional Knowledge:

Art (in the context of civilian awards) includes cinema, theatre, music and visual arts.
Literature would have been awarded for significant writing or publishing work.
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Public Affairs nominations typically address politics, administration or social service.
Journalism relates to reporting, media and news-analysis contributions.

Q.37   Which among the following is not in the list of UNESCO World Heritage sites in India?

A. Rani ki Vav, Gujarat
B. Chhattrapati Shivaji Terminus, Maharashtra
C. Bhimbetka Caves, Madhya Pradesh
D. Bada Imambara, Uttar Pradesh

Answer: D

Sol: The correct answer is (d) Bada Imambara, Uttar Pradesh.
Explanation:

The Bada Imambara in Lucknow, Uttar Pradesh, is a significant historical and architectural monument, but it is not inscribed on the
UNESCO World Heritage List.
It is a grand complex built in 1784 by Nawab Asaf-ud-Daula, known for its unique architecture, including one of the world's largest
unsupported arches.
Rani ki Vav in Gujarat, Chhatrapati Shivaji Terminus in Maharashtra, and Bhimbetka Caves in Madhya Pradesh are all recognized as UNESCO
World Heritage sites.

Information Booster:

As of 2025, India has 44 UNESCO World Heritage Sites, comprising 36 cultural, 7 natural, and 1 mixed site.
India ranks sixth globally in the number of World Heritage Sites.
In addition to the inscribed sites, India has a large tentative list of sites that have been submitted to UNESCO for consideration.

Additional Knowledge:
(a) Rani ki Vav, Gujarat:

Rani ki Vav (The Queen's Stepwell) in Patan, Gujarat, was inscribed as a UNESCO World Heritage site in 2014.
It is an elaborately carved stepwell built in the 11th century, recognized for its architectural and artistic significance.
(b)

Chhatrapati Shivaji Terminus, Maharashtra:

Chhatrapati Shivaji Terminus (formerly Victoria Terminus), Mumbai, was inscribed in 2004.
It is a historic railway station known for its Victorian Gothic Revival architecture.
(c) Bhimbetka Caves, Madhya Pradesh:
The Rock Shelters of Bhimbetka in Madhya Pradesh were designated a UNESCO World Heritage site in 2003.
These prehistoric rock shelters contain ancient rock paintings dating back to the Paleolithic and Mesolithic periods.

Q.38   Which secret society founded by Vinayak Damodar Savarkar promoted armed revolution against the British rule?

A. Abhinav Bharat
B. Anushilan Samiti
C. Hindustan Socialist Republican Association
D. Ghadar Party

Answer: A

Sol: The correct answer is (A) Abhinav Bharat
Explanation:
● Abhinav Bharat Society was founded in 1904 by Vinayak Damodar Savarkar and his brother Ganesh Savarkar.
● It promoted armed revolution and nationalist propaganda against British colonial rule.
● The society later merged with other revolutionary groups and influenced future revolutionaries.
Information Booster:
● Founded in Nasik, Maharashtra.
● Inspired by Italian revolutionary Giuseppe Mazzini.
● Savarkar also authored ‘The Indian War of Independence – 1857’.
● Members used secret oaths and coded communication.
● British banned Abhinav Bharat in 1910.
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Additional Knowledge:
● Anushilan Samiti – Revolutionary group based in Bengal.
● HSRA – Founded by Bhagat Singh & Chandrashekhar Azad (1928).
● Ghadar Party – Founded in USA & Canada to overthrow British rule.

Q.39   Who received the inaugural FIFA Peace Prize during the 2026 FIFA World Cup draw ceremony?

A. Joe Biden
B. Gianni Infantino
C. Donald Trump
D. António Guterres

Answer: C

Sol: The correct answer is (c) Donald Trump.
• Trump was awarded the first-ever FIFA Peace Prize on 5 December 2025.
• Ceremony held at the Kennedy Center, Washington, D.C.
• Award recognised his claimed peace-promoting efforts worldwide.
Information Booster:
• FIFA Peace Prize introduced under FIFA’s new “social responsibility” programme.
• Prize includes a trophy, medal, and certificate.

Q.40   Gir Forest National Park is famous for the conservation of which animal?

A. Indian Rhinoceros
B. Asiatic Lion
C. Indian elephant
D. Bengal Tiger

Answer: B

Sol: The correct answer is: (b) Asiatic Lion
Explanation:
· Gir Forest National Park, located in Gujarat, is the only natural habitat of the Asiatic Lion (Panthera leo persica) in the world.
· It was established as a sanctuary in 1965 to protect the dwindling population of Asiatic lions.
· Due to strict conservation efforts, the lion population has significantly increased in recent decades.
Information Booster:
· Gir National Park covers an area of about 1,412 sq km.
· The 2020 census reported 674 Asiatic lions in Gujarat.
· Asiatic lions are slightly smaller than African lions and have a distinctive fold of skin along the belly.
· Gir is also home to leopards, striped hyenas, and over 300 bird species.
· Asiatic lions are listed as Endangered on the IUCN Red List.
Additional Knowledge:
· Indian Rhinoceros: Found mainly in Kaziranga National Park, Assam.
· Indian Elephant: Found in Periyar (Kerala), Nilgiri Biosphere, and North-East India.
· Bengal Tiger: Famous in Sundarbans (West Bengal) and Jim Corbett (Uttarakhand).

Q.41   In the following question, select the related word from the given alternatives.
Watt : Power :: Pascal : ?

A. Energy
B. Temperature
C. Pressure
D. Force

Answer: C
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Sol: Given:
Watt : Power :: Pascal : ?
Logic: Just as power is measured in watts, pressure is measured in pascals. So the same relationship applies.
A watt is the SI unit used to measure power.
A pascal is the SI unit used to measure pressure.
Thus, correct option is (c) Pressure.

Q.42   A is the sister of H. H is the father of E. E is the son of N. M is the mother of N. How is A related to N?

A. Daughters husbands mother
B. Daughters husbands sister
C. Husbands mother
D. Husbands sister

Answer: D

Sol: Information Given:
A is the sister of H.
H is the father of E.
E is the son of N.
M is the mother of N.
Question: How is A related to N?

A is H’s sister → A = husband’s sister.

Final Answer:
Husband's sister

Final Correct Option:
(D)

Q.43   Which of the following numbers will replace the question mark (?) in the given series?
2548, 3150, ?, 4624, 5508​

A. 4096
B. 3840
C. 3375
D. 3600
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Answer: B

Sol: Given: 2548, 3150, ?, 4624, 5508

Thus, correct option is (b) 3840.

Q.44   Find the missing term in the given series:
G13, H15, I17, ____ , K21

A. J26
B. F16
C. M22
D. J19

Answer: D

Sol: Letters:
G → H → I → J → K
(alphabet increases by +1 each step)

Numbers:
13 → 15 → 17 → 19 → 21
(increasing by +2 each step)

So the missing term is:

J19

Q.45   If 3 * 5 * 6 = 92536 and 2 * 4 * 9 = 41681, then 7 * 8 * 10 is equal to

A. 6410049
B. 813625
C. 98164
D. 4964100

Answer: D

Sol: Given: If 3 * 5 * 6 = 92536 and 2 * 4 * 9 = 41681
Logic: Square of numbers and write simply.
For, 3 * 5 * 6 = 92536
3 = 9, 5 = 25, 6 = 36
3 * 5 * 6 = 92536
For, 2 * 4 * 9 = 41681
2 = 4, 4 = 16, 9 = 81
2 * 4 * 9 = 41681
Similarly,
7 * 8 * 10 = ?
7 = 49, 8 = 64, 10 = 100
So, 7 * 8 * 10 = 4964100
Thus, correct option is (d).

2 2 2

2 2 2

2 2 2

Q.46   Complete the analogy.

India : Rupee : : Armenia : ?
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A. Manat
B. Dram
C. Lari
D. Bhat

Answer: B

Sol: Logic- Country: Currency

India : Rupee : : Armenia : ?

Dram is the currency of Armenia.

Here, Armenia : Dram is the correct pair.

Hence, Option(B) is the answer.

Additional Information

Country Currency

Thailand Bhat

Azerbaijan Manat

Georgia Lari

Q.47   Complete the given series:
362, 364, _, 368, 370

A. 379
B. 365
C. 366
D. 371

Answer: C

Sol: The series is:

362, 364, __ , 368, 370

Observe the pattern:

Each term increases by +2.

So:

362
362 + 2 = 364
364 + 2 = 366
366 + 2 = 368
368 + 2 = 370
​
Final Answer: 366
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Q.48
 

In the following number-pairs, the second number is obtained by applying certain mathematical operations to the first number. Select the set in
which the numbers are related in the same way as are the numbers of the following sets.
(NOTE: Operations should be performed on the whole numbers, without breaking down the numbers into their constituent digits. E.g. 13 –
Operations on 13 such as adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3 and then performing
mathematical operations on 1 and 3 is not allowed.)
24, 66
18, 48

A. 22, 58
B. 30, 84
C. 20, 56
D. 28, 74

Answer: B

Sol: Given:
24 → 66
18 → 48
Logic: Each second number is obtained by:
(First number × 3) – 6
Explanation:
24 × 3 = 72 → 72 – 6 = 66
18 × 3 = 54 → 54 – 6 = 48
Now check the options using the same rule:
A) 22 × 3 – 6 = 66 – 6 = 60 ≠ 58
B) 30 × 3 – 6 = 90 – 6 = 84 (Correct)
C) 20 × 3 – 6 = 60 – 6 = 54 ≠ 56
D) 28 × 3 – 6 = 84 – 6 = 78 ≠ 74
Thus, correct option is (B).

Q.49   Select the option that represents the correct order of the given words as they would appear in an English dictionary.
1. Little
2. Literature
3. Liquid
4. Light

A. 4,3,2,1
B. 4,2,1,3
C. 3,4,1,2
D. 4,1,3,2

Answer: A

Sol: Solution:

The logic followed here is:

Light (L I G...) — G comes before Q and T, so Light is first.

Liquid (L I Q...) — Q comes before T, so Liquid is next.

Literature (L I T E...) — after “lit”, E comes before the next letter of Little.

Little (L I T T...) — comes last.

So, the correct dictionary order is Light, Liquid, Literature, Little

→ 4, 3, 2, 1.

Hence, the correct answer is "Option (A)".
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Q.50   Find the value of ' k ' in the given table.

3 10 21

k 2296

131752

A. 16
B. 18
C. 12
D. 14

Answer: A

Sol: Logic: (Second Number - First Number) × First Number = Third Number

Row (1) → (10 - 3) × 3 = 7 × 3 = 21

Row (3) → (17 - 13) × 13 = 4 × 13 = 52

Similarly:

Row (2) → (22 - K) × K = 96

Put K =16, (22 - 16) × 16 = 6 × 16 = 96

Here, the value of K is 16.

Hence, Option(A) is the answer.

Q.51
 

On the basis of general mental ability and general mental understanding only, without regard to scientific and technical facts, Which of the
following options will replace the question mark on the basis of tool and its action?
Knife : Cut :: Shield:?​​​

A. Guard
B. Grip
C. Write
D. Magnification

Answer: A

Sol: Given: Knife : Cut :: Shield:?​​​
A knife is a tool used to cut.
The second word is the function or action of the tool.
Similarly,
Shield : ?
A shield is a tool used to guard or protect.
So, Shield : Guard
Thus, correct option is (a).

Q.52   Find the related number to complete the analogy.
7261 : 9483 : : 5314 : ?

A. 6341
B. 8647
C. 6425
D. 7536

Answer: D

Sol: The logic followed here is:
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Here simply 2222 is being added to the first term to obtain the second term.

5314 + 2222 = 7536 will be the next term according to the logic.

Hence, Option (D) is the answer.

Q.53
 

Based on the English alphabetical order, three of the following four letter-clusters are alike in a certain way and thus form a group. Which letter-
cluster DOES NOT belong to that group? Note The odd one out is not based on the number of consonants/vowels or their position in the letter-
cluster.

A. PTN
B. JNH
C. MQK
D. GKF

Answer: D

Sol: Information Given:
Options: A PTN, B JNH, C MQK, D GKF.

Logic:
Convert letters to positions; check successive shifts.

Explanation:
Logic: map letters to numbers and look at differences.
PTN: P(16) → T(20) → N(14) : +4, −6.
JNH: J(10) → N(14) → H(8) : +4, −6.
MQK: M(13) → Q(17) → K(11) : +4, −6.
GKF: G(7) → K(11) → F(6) : +4, −5 → does not match.

Short Trick:
Three clusters follow +4 then −6; the odd one has −5.

Final Answer:
GKF

Final Correct Option:
(D)

Q.54   In the following question, select the odd word from the given alternatives.

A. Table Tennis
B. Cricket
C. Carrom
D. Chess

Answer: B

Sol: ​​All others (Table Tennis, Carrom, Chess) are commonly played indoors.
Cricket is the only game that is strictly outdoor and team-based
Also, all others can be played on a table or board, while Cricket requires a large field.
So, odd one out is: Cricket
Thus, the correct option is: (b)

Q.55   Which word cannot be formed from the letters of LEARNING?

A. GRAIN
B. LINE
C. ANGLE
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D. GREEN

Answer: D

Sol: "GREEN" contains the letter E twice. But "LEARNING" has only one E, so "GREEN" cannot be formed. Correct answer: (d).

Q.56   In the following question, select the related letter pair from the given alternatives.
MAV : PEA :: ?

A. ADX : DHB
B. NQS : QVX
C. RCT : UFY
D. PFE : SJJ

Answer: D

Sol: Given:
MAV : PEA :: ?
Logic: add 3, then 4, then 5 to the three letters.

MAV : PEA
M + 3 = P, A + 4 = E, V + 5 = A
Check options:
A) A + 3 = D, D + 4 = H, X + 5 = C → gives DHC (not DHB)
B) N + 3 = Q, Q + 4 = U, S + 5 = X → gives QUX (not QVX)
C) R + 3 = U, C + 4 = G, T + 5 = Y → gives UGY (not UFY)
D) P + 3 = S, F + 4 = J, E + 5 = J → gives SJJ
Only D follows the same rule.
Thus, correct option is (d).

Q.57   In the following question, choose the odd word from the given alternatives.

A. Crocodile
B. Lizard
C. ​Chamaeleon
D. Rat

Answer: D

Sol: ​Common features:
Crocodile → Reptile
Lizard → Reptile
Chamaeleon → Reptile (a type of lizard)
Rat → Mammal
So, the Odd One: Rat is the only mammal; the others are reptiles.
Thus, the correct option is: (d)

Q.58
 

If ‘A’ stands for ‘÷’, ‘B’ stands for ‘×’, ‘C’ stands for ‘+’ and ‘D’ stands for ‘–’, what will come in place of the question mark (?) in the following
equation?
23 B 4 D 45 A 9 C 11 = ?

A. 90
B. 75
C. 85
D. 98

Answer: D

Sol: Given:
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23 B 4 D 45 A 9 C 11 = ?

AlphabetABCD

Sign ÷×+ -

​​

New equation: 23 × 4 – 45 ÷ 9 + 11 = ?
23 × 4 – 5 + 11 = ?
92 – 5 + 11 = ?
103 – 5 = ?
? = 98
Thus, correct option is (d).

​​ ​

Operation preference wise
Brackets
Orders, of
Division

Multiplication
Addition

Subtraction

Symbol
[], , ()

(power), √(root), of
÷
×
+
−

Q.59
 

Gyamel starts from Point A and drives 20 km towards West. He then takes a left turn, drives 18 km, turns left and drives 23 km. He then takes a left
turn and drives 25 km. He takes a final left turn, drives 3 km and stops at Point P. How far shortest distance and towards which direction should he
drive in order to reach Point A again? All turns are 90 turns only unless specified.

A. 5 km to the West
B. 4 km to the South
C. 7 km to the South
D. 6 km to the North

Answer: C
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Sol: Information Given:
Gyamel starts from Point A and drives 20 km towards West. He then takes a left turn, drives 18 km, turns left and drives 23 km. He then takes a left
turn and drives 25 km. He takes a final left turn, drives 3 km and stops at Point P. How far shortest distance and towards which direction should he
drive in order to reach Point A again? All turns are 90 turns only unless specified.​

Final Answer:
shortest distance (25 - 18 = 7 Km) and towards south direction should he drive in order to reach Point A again.

Final Correct Option:
(C)

Q.60   Which of the following is the odd one out?

A. 2, 3, 5
B. 11, 13, 17
C. 4, 6, 8
D. 7, 19, 23

Answer: C

Sol: Check each options;
A) 2, 3, 5 → consecutive primes
B) 11, 13, 17 → consecutive primes
C) 4, 6, 8 → not primes, not consecutive
D) 7, 19, 23 → primes but not consecutive
Thus, odd one out is (c).

Q.61   The total age of three children in a family is 27 years. What will be the total of their ages after 3 years?

A. 30
B. 33
C. 36
D. 39

Answer: C
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Sol:
Given:
Total present age = 27 years
Number of children = 3
Increase in age = 3 years
Formula Used:
Increase in total age = Number of persons × Increase in years
Solution:
Increase in total age = 3 × 3 = 9
New total age = 27 + 9 = 36

Q.62   Sonia runs 12 laps every day for 2 weeks. How many laps does she run in total?

A. 156
B. 164
C. 168
D. 172

Answer: C

Sol:
Given:
Laps per day = 12
Number of weeks = 2
Formula Used:
Total laps = Laps per day × Number of days
Solution:
Number of days = 2 × 7 = 14
Total laps = 12 × 14 = 168

Q.63   A farmer builds a fence around a square field. If each side of the field is 18 metres, what is the total length of the fence?

A. 54 m
B. 64 m
C. 72 m
D. 80 m

Answer: C

Sol:
Given:
Side of square = 18 m
Formula Used:
Perimeter of square = 4 × side
Solution:
Perimeter = 4 × 18 = 72 m

Q.64   There are 120 students in a group. For every 5 students, there is 1 captain. How many captains are there?

A. 20
B. 22
C. 24
D. 25

Answer: C
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Sol:
Given:
Total students = 120
Students per captain = 5
Formula Used:
Number of captains = Total students ÷ Students per captain
Solution:
Number of captains = 120 ÷ 5 = 24

Q.65   The diameter of a circle is 14 cm. What is its radius?

A. 5 cm
B. 6 cm
C. 7 cm
D. 14 cm

Answer: C

Sol:
Given:
Diameter = 14 cm
Formula Used:
Radius = Diameter ÷ 2
Solution:
Radius = 14 ÷ 2 = 7 cm

Q.66   How many faces does a cube have?

A. 4
B. 6
C. 8
D. 12

Answer: B

Sol:
Given:
Solid figure = Cube
Formula Used:
Standard properties of cube
Solution:
A cube has 6 faces

Q.67   A cloth roll of 240 metres is cut into pieces of equal length. If each piece is 6 metres long, how many pieces are obtained?

A. 30
B. 35
C. 40
D. 45

Answer: C

Sol:
Given:
Total length = 240 m
Length of each piece = 6 m
Formula Used:
Number of pieces = Total length ÷ Length of each piece
Solution:
Number of pieces = 240 ÷ 6 = 40
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Q.68   If the cost price of an article is ₹400 and it is sold at ₹480, what is the profit?

A. ₹60
B. ₹70
C. ₹80
D. ₹90

Answer: C

Sol:
Given:
CP = ₹400, SP = ₹480
Formula Used:
Profit = SP − CP
Solution:
480 − 400 = ₹80

Q.69   Find the value of: (−25) + (+18)

A. −7
B. −9
C. 7
D. 9

Answer: A

Sol:
Given:
Numbers = −25 and +18
Formula Used:
Addition of integers
Solution:
−25 + 18 = −7

Q.70   What is the value of: 7² + 3²?

A. 49
B. 58
C. 62
D. 64

Answer: B

Sol:
Given:
Expression = 7² + 3²
Formula Used:
Square of numbers
Solution:
7² = 49
3² = 9
49 + 9 = 58

Q.71   What is the Roman numeral for 39?

A. XXXIX
B. XXIX
C. XL
D. XXXV

Answer: A
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Sol:
Given:
Number = 39
Formula Used:
Roman numeral rules
Solution:
39 = 30 + 9
30 = XXX
9 = IX
39 = XXXIX

Q.72   If the product of two numbers is zero, then one of the numbers must be:

A. 1
B. −1
C. 0
D. 10

Answer: C

Sol:
Given:
Product of two numbers = 0
Formula Used:
Zero property of multiplication
Solution:
If product is zero, at least one number must be zero

Q.73   If the perimeter of a square is 64 cm, what is the length of one side?

A. 12 cm
B. 14 cm
C. 16 cm
D. 18 cm

Answer: C

Sol:
Given:
Perimeter = 64 cm
Formula Used:
Side = Perimeter ÷ 4
Solution:
64 ÷ 4 = 16 cm

Q.74   What is the sum of the first five multiples of 4?

A. 40
B. 50
C. 60
D. 70

Answer: C

Sol:
Given:
First five multiples = 4, 8, 12, 16, 20
Formula Used:
Sum of numbers
Solution:
4 + 8 + 12 + 16 + 20 = 60
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Q.75   If 8 pens cost ₹96, what is the cost of 15 pens?

A. ₹160
B. ₹170
C. ₹180
D. ₹190

Answer: C

Sol:
Given:
Cost of 8 pens = ₹96
Formula Used:
Cost per pen = Total cost ÷ Number of pens
Solution:
Cost of 1 pen = 96 ÷ 8 = 12
Cost of 15 pens = 12 × 15 = 180

Q.76   What is the fraction of a half?

A. 1/4
B. 2/4
C. 3/4
D. 4/4

Answer: B

Sol:
Given:
Half = 1/2
Formula Used:
Equivalent fractions
Solution:
1/2 = 2/4

Q.77   If 72 ÷ 8 × 5 = ?

A. 40
B. 42
C. 45
D. 48

Answer: C

Sol:
Given:
Expression = 72 ÷ 8 × 5
Formula Used:
BODMAS Rule
Solution:
72 ÷ 8 = 9
9 × 5 = 45

Q.78   If 3 dozen apples are distributed equally among 6 people, how many apples does each person get?

A. 4
B. 6
C. 8
D. 12

Answer: B
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Sol:
Given:
3 dozen = 36 apples, People = 6
Formula Used:
Division method
Solution:
36 ÷ 6 = 6

Q.79   Find the next number in the series: 15, 24, 33, 42, ?

A. 51
B. 52
C. 53
D. 54

Answer: A

Sol:
Given:
Series = 15, 24, 33, 42
Formula Used:
Difference method
Solution:
Common difference = 9
Next term = 42 + 9 = 51

Q.80   What is the value of: 156 ÷ 3 + 100?

A. 148
B. 150
C. 152
D. 156

Answer: C

Sol:
Given:
Expression = 156 ÷ 3 + 100
Formula Used:
BODMAS Rule
Solution:
156 ÷ 3 = 52
52 + 100 = 152

Q.81   How can you change the font color in PowerPoint?

A. Go to the Font section in the Home tab and select Font Color
B. Right-click the text and choose Change Color
C. Press Ctrl + C
D. Use the Design tab to select a color

Answer: A

Sol: In PowerPoint, you can change the font color by navigating to the Home tab and selecting the Font Color option in the Font section. This allows
users to apply different colors to text for better emphasis, readability, or visual appeal in presentations.
Important Key Points:
1. Font Section in the Home Tab: The Font Color option is located in the Home tab under the Font section, where users can choose from
preset colors or create custom colors.
2. Highlighting Text: Changing font color helps differentiate key points or highlight important content in a presentation.
3. Theme and Standard Colors: PowerPoint provides theme colors (matching the presentation design) and standard colors (fixed choices).
4. Gradients and Effects: Users can also apply text effects like gradients, shadows, and reflections through the Font Color menu.
Knowledge Booster:
· Right-click the text and choose Change Color – This option does not exist in PowerPoint. Right-clicking text provides options like Font,
Paragraph, or Format Shape, but not direct color change.
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· Press Ctrl + C – This shortcut is for copying text and does not affect font color.
· Use the Design tab to select a color – The Design tab is used for changing the slide theme, background, and layout, not for modifying font
color.

Q.82   Which of the following keyboard shortcuts can be used to insert a hyperlink in an MS Word document?

A. Alt + K
B. Alt + L
C. Ctrl + K
D. Ctrl + L

Answer: C

Sol: In MS Word, the keyboard shortcut Ctrl + K is used to insert a hyperlink into the document. Pressing Ctrl + K opens the Insert Hyperlink dialog
box, where you can enter the URL or web address, and the display text that will appear as a clickable link.
Important Key Points:
1. Ctrl + K: This shortcut is widely used in MS Word to insert hyperlinks, whether linking to external websites, email addresses, or internal document
references.
2. Hyperlink Dialog Box: Once Ctrl + K is pressed, the Insert Hyperlink dialog allows you to choose the type of link (e.g., web page, email, or
document) and input the relevant details.
Knowledge Booster:
· Alt + K: This is not a standard shortcut for inserting hyperlinks in MS Word.
· Ctrl + L: Ctrl + L is used for left-aligning text in the document, not for inserting hyperlinks.
· Alt + L: This shortcut does not have a predefined function for inserting hyperlinks.

Q.83   Which of the following is a keyboard shortcut in Windows 10 OS to switch between open apps?

A. Ctrl + Tab
B. Alt + Tab
C. Shift + Tab
D. Enter + Tab

Answer: B

Sol: The correct answer is (b) Alt + Tab
Explanation:
• Alt + Tab shows all open applications and allows switching between them.
• One of the most widely used Windows navigation shortcuts.
• Enhances multitasking efficiency.
Information Booster:
• Windows + Tab opens Task View for virtual desktops.

Q.84   Which of the following is an example of Operating System for Desktop or Laptop?

A. Web OS
B. Chrome OS
C. Apple iOS
D. Palm OS

Answer: B

Sol: The correct answer is (b) Chrome OS
Explanation:
• Chrome OS is a Linux-based operating system designed by Google for desktops and laptops such as Chromebooks.
• It supports web-based applications and is optimized for cloud computing.
• It is widely used in educational and personal computing environments.
• Runs efficiently even on low-power hardware.
Information Booster:
• Chrome OS primarily uses the Chrome browser as its main interface.
• It supports Android apps via Google Play Store.
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Q.85   What is MS PowerPoint?

A. A word-processing application
B. A presentation software
C. A database management tool
D. A web browsing application

Answer: B

Sol: MS PowerPoint is specifically designed for creating and delivering presentations. It allows users to design slideshows using text, images, videos, and
other multimedia elements, making it an effective tool for visual communication in business, education, and various other fields.
Important Key Points:
1. Presentation Software: MS PowerPoint is a software tool used to create and deliver presentations. It helps users design slides with different
layouts, animations, and multimedia elements to effectively present information.
2. Multimedia Integration: The software allows the inclusion of text, images, charts, audio, and video, enabling the creation of interactive and
engaging presentations.
3. User-Friendly Interface: PowerPoint provides a simple and intuitive interface that enables both beginners and advanced users to create
presentations with ease.
Knowledge Booster:
· A word-processing application: MS PowerPoint is not a word-processing application. Although it includes text editing features, MS Word is the
appropriate software for word processing and creating text documents.
· A database management tool: MS PowerPoint is not used for managing databases. Database management is handled by tools like MS Access,
which is designed for storing, retrieving, and managing data.
· A web browsing application: MS PowerPoint is not a web browser. Browsing the internet is done through web browsers like Google Chrome,
Firefox, or Microsoft Edge, not through PowerPoint.

Q.86   Which of the following appears at the end of an MS-Word 365 document?

A. Endnote
B. Subscript
C. Footnote
D. Header

Answer: A

Sol: The correct answer is (a) Endnote
Explanation:
• Endnotes appear at the end of a document or section.
• Used for citations, references, and additional information.
• Automatically numbered and linked to the text.
• Managed through the “References” tab in MS-Word.
Information Booster:
• Word provides both Footnotes (bottom of page) and Endnotes (end of document).
• Conversion between Footnotes and Endnotes is also possible.

Q.87   How many main types of ROM are commonly found in computer systems?

A. Two
B. Three
C. Four
D. Five

Answer: C

Sol: ROM comes in four principal varieties:
· Mask ROM, programmed during manufacturing and never changed.
· PROM (Programmable ROM), which you can write once after it’s made.
· EPROM (Erasable PROM), which you erase with ultraviolet light before rewriting.
· EEPROM (Electrically Erasable PROM), which you erase and reprogram electrically.
Because these four cover the standard options for storing permanent firmware, the correct answer is four.
Important Key Points:
1. Mask ROM is set at the factory and cannot be altered.
2. PROM lets you add data one time only, using a special programmer.
3. EPROM chips have a little quartz window so UV light can clear them.
4. EEPROM allows you to update individual bytes without removing the chip.
Knowledge Booster:
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5. Flash memory is really a high-density form of EEPROM, offering faster block erasure for devices like USB drives and SSDs.
6. Many motherboards store BIOS or UEFI firmware in an EEPROM/flash chip so updates can be applied in the field.
7. Unlike volatile RAM, all these ROM types retain data without any power source.

Q.88   Which of the following text formatting tasks is achieved with the help of keyboard shortcut Ctrl + E?

A. Justify
B. Align Right
C. Align Left
D. Align Center

Answer: D

Sol: Correct Answer: (d) Align Center

Explanation:

In MS-Word, the shortcut Ctrl + E is used to center-align the selected text or paragraph.
It places the text equally spaced between the left and right margins.

Information Booster:

Other important alignment shortcuts in MS-Word:
Ctrl + L → Align Left
Ctrl + R → Align Right
Ctrl + J → Justify

Center alignment is commonly used for titles, headings, and cover pages.

Q.89   Which of the following is NOT an input device?

A. Mouse
B. Speaker
C. Optical Character Reader (OCR)
D. Digitizer

Answer: B

Sol: The correct answer is (B) Speaker.
Explanation:
A speaker is an output device, not an input device. It converts digital signals into sound. On the other hand, a mouse, optical character reader
(OCR), and digitizer are all input devices that provide data to the computer.

Information Booster:

Input Devices: These devices allow users to enter data into a computer. Examples include a keyboard, mouse, scanner, and microphone.

Output Devices: These devices provide feedback from the computer to the user, such as a monitor, speaker, and printer.

OCR (Optical Character Reader): A device that scans and converts printed text into digital format for processing by the computer.

Digitizer: A device that converts analog data into digital format, used for creating digital representations of physical drawings or maps.

Additional Knowledge:

Keyboard: A common input device for entering text and commands.

Monitor: A standard output device that displays visual information from the computer.

Printer: An output device used to produce a physical copy of digital content.
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Q.90   Which of the following belongs to the first generation of computers?

A. ENIAC
B. Napier’s Bones
C. Abacus
D. Pascaline

Answer: A

Sol: The correct answer is (a) ENIAC
Explanation:
• ENIAC is one of the earliest first-generation electronic computers (1940s).
• It used vacuum tubes for processing.
• First-generation computers consumed high power and generated heat.
• Examples: ENIAC, UNIVAC-I.
Information Booster:
• First-generation computers used machine language only.
• They relied entirely on vacuum tube technology.
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